18.feladat: Miveletek domborzatmodellekkel

Feladat: Ebben a feladatban készitliink egy olyan hipszometrikus térképet
domborzatarnyékoldssal Nyugat-Eurdpardl, amelyen a holland mélyfoldek nem fognak
,belesiillyedni” a tengerbe. Emellett domborzatarnyékolas, szintvonalrajz, magassagi profil és
3D nézet is késziiljon!

Problémafelvetés: Az SRTM nem tartalmaz mélységi adatokat a tengerekrol (kivétel részben
a part menti self teriiletek). Az ETOPOI egy olyan globalis domborzatmodell, amely egy perc
(kb. 2 km) térbeli felbontéssal tartalmaz magassagi illetve mélységi adatokat az egész Foldrol.
Tobbféle forrasbol allitottak ossze, részletek a hivatalos honlapjukon:

HTTP: //WWW.NGDC . NOAA .GOV/MGG/GLOBAL/GLOBAL . HTML

Ebbdl készitettem egy kivagatot, eTrorol . T1F néven, mellékeltem mellé egy orszaghatarok
allomanyt is (COUNTRIES WEST EUROPE . SHP).

Készitendd egy olyan raszteres térkép, amelyben a mélyfoldek zoldjét kiilon tudom éallitani a
tenger kékjéhez képest, vagyis elkiiloniilnek a szarazfoldi és tengeri tertiletek.

Megoldas, magyarazat

Adjunk hozza Uj raszteres réteget, a Layer > Add Raster Layer menUbdl.

Készitsink hipszometrikus térképet. A Properties ablak Style filén valasszuk a Singleband
Pseudocolor-t (Egysavos alszines). A zold + jel segitségével adjunk hozza néhany szintvonal
kategoriat, legyenek ezek (-1000, -200, -100, 0, 100, 200, 500, 1000, 2000 m). A Color
interpolation -t pedig allithatjuk akar Linear-rol (szindtmenet) Discrete-re (diszkrét
szineloszlas, klasszikus magassagi szinezéses térkép). A kett6 kozott az a kilonbség, hogy a
linedrisnal a megadott két szin k6zott atmeneti szineket is hasznal, mig a diszkrétnél csak a
megadott szineket. A Labelhez jelmagyarazat készithetd.


http://www.ngdc.noaa.gov/mgg/global/global.html
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A kovetkezd lépés a vektoros hatar réteg megnyitasa, és 6sszevetése a magassagokkal.
TegyUk atlatszova részben a vektoros réteget, a Properties, Style, Layer rendering
bekezdésnél, Layer transparency.

A) Megoldas

A feladat egyszerUen is megoldhatd. Ehhez nyissuk meg a kivagatot a
domborzatmodellbdl, illetve a countries_west_europe (hatarok) réteget.
Kattintsunk a Raster meniben, az Extraction>Clipper modulra. A modullal




raszteres rétegekbdl lehet kivagni részleteket, példaul téglalapszerien, vagy egy
vektoros réteggel akar szabalytalan részleteket.

Input fajl ebben az esetben a domborzatmodell, allitsuk be a mentés helyét is.

Ha a Clipping mode-nél az Extent-et valasztjuk, téglalap alaku terUletek vaghatok, itt vagy
begépeljik a sarokkoordinatakat, vagy a térképre rajzolunk egy box-ot. Ebbdl a QGIS
automatikusan kinyeri sarokpontok koordinatait. Masik lehet6ség a Mask layer. Ezt fogjuk
most hasznalni a countries-zel. Ne felejtsUk el megadni a Null data values, ott megadhato,
hogy azokon a terileteken, ahol nincs semmi (nalunk ez a tenger), ott mi legyen a pixelérték.
Valasszuk pl. a-999999999.000000-et, ezt felismeri majd a szoftver és atlatszonak értelmezi.
A moivelet eredménye egy Uj raszteres réteg, amelyen atvettUk az eredeti rétegrdl a
szarazfoldek magassagait, a tengereken mindenhol pedig a pixelérték -999999999. igy ez a
rész atlatszik majd ha az eredeti ETOPOa réteg folé helyezzUk.

Folytassuk lentebb a B) megoldas utan!

A vektoros rétegbdl rasztereset szeretnénk késziteni, de miel&tt ezt megtennénk, ossze kell
olvasztani az egyes orszaghatarokat. Vector meniu, Geoprocessing Tools, Dissolve.

Ezek utan a kontinenshatarokat tartalmazé réteginkbdl gyartunk raszteres réteget. Ezt a
funkciot a Raster meni > Conversions> Rasterize (Vector to raster) lehet elérni. A
bemeneti allomany (Input layer) beallitasa utan A fixed value to burn legyen 1. Output
raster size units (pixel), Width és height olvassuk ki az etopox réteg Properties-bdl (source
ful). Output extent itt kivalasztjuk a réteget (etopo1). Assigned to a specified no data value:
lehet 0. Advanced: Output data type Float32 bites tif. és a Rasterized: az Uj fajl neve.
Kapunk egy raszteres allomanyt (o_1.tif), amely a szarazféldeken mindenhol 1 a tengereken
pedig o értéket tartalmaz.

Ezt 6sszeszorozva az ETOPOz1-el, (Raster calculator-ban hajtjuk végre a miveletet) az
oceanok eltinnek a fajlbdl, és a szarazfoldek megdrzik eredeti magassagukat.

etopo1@1 *o_1@1

Mindkét allomany 32-bite tif, ezért csak egy csatornéja van (@1). Allitsuk még be a kimeneti
allomany fajlnevét és CRS-sét.
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Ezutan mar csak annyi a dolgunk, hogy beallitjuk a hipszometriat a korabban ismertetett
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modon, (mélyfoldek legyenek sotétzoldek), és a rétegkezeloben felilre helyezzik a csak
szarazfoldeket tartalmazo réteget.
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Adjunk hozza domborzatarnyékolast is!

A domborzatarnyékolas létrehozasara szamos lehetdség kinalkozik mar a QGIS 3-ban.
Fontos, hogy olyan vetiletet valasszunk, amelyben a méterben vannak a koordinataink. (pl.
UTM stb.) Nézzik meg ezeket! Az elsd és legegyszer(bb:
1.) Properties-ben
Duplikaljuk a domborzati réteginket (Ujra behivjuk vagy, jobb klikk Duplicate Layer.)
Nyissuk meg a Properties ablakot az Uj rétegen. A Symbology>Render
Type>Hillshade.
Beallithatd a megvilagitas iranya (azimuth), a fényforras magassaga (altitude), és egy
Z factor, amely méterrendszer( koordinataknal 1.

A Z factor-t, ami a vertikalis tUlmagasitast jelenti. Tulajdonképpen két érték johet
szoba, ez a réteg vetlletétdl figg, ezt ellendrizzik mindig a Properties (general
beallitasainal). Ha a réteg vetilete olyan, hogy a vizszintes koordinatak foldrajzi
koordinatak, vagyis fokban vagyunk, akkor a pl. Z=0,001. (0,0005-0,001 kdz&tt). Ha
méterben megadott a vizszintes koordinatak, akkor pl. Z=1 (1-5 k6z6tt). 1-nél nincs
tulmagasitas.

A megvilagitas iranyat az azimuth-nal, a vertical angle-nél pedig a nap magassagat
lehet megadni. A térképészetben hagyomanyosan a megvilagitas iranya ENY (315°)
és a,Nap” 45° magasan all. Oka: régen a rajzolok tobbsége jobb kezes volt, ha a fény
a papiron a bal felsé sarokbdl érkezik, akkor az abra jobb also részét kell arnyalni, ami
a jobbkezeseknek , kézre allt”.



Miutan megvan az arnyékolas réteg tobbféleképpen is kombinalhatjuk a
rétegszinezéssel, Helyezzik a rétegszinezés folé ezt a réteget, és Properties,
Transparency filnél tegyUk atlatszova 30-40%-ban.

A masik mddszer, hogy az arnyékolas réteget ,,0sszeolvasztjuk” a rétegszinezéssel.
Properties> Style-> Color rendering: Blend mode: Multiply.

A Brightness és s Contrast izlés szerint allithatd. (Ne legyen tul sotét a kép, mert
akkor a névrajz olvashatatlanna valik!)

o -

Layers ®

2.) A Raster meniben Analysis almenijében a Hillshading jelenti a
domborzatarnyékolas hozzaadasat.
Itt tobbféle dolog is allithatd: A fényforras helye, magassaga, a vertikalis tulmagasitas
értéke, és a méretarany (horizontalis és vertikalis méretarany egymashoz valo
viszonya).
Compute edges: A széleken is szamitsa ki az arnyékolast.
Use Zevenbergen-Thorne fomula instead of Horn’s one: Zevenbergen-Thorne
maddszert hasznalja, 1asd lentebb.
Combined shading: A ferde és a lejt0sz6g alapjan szamitott arnyékolas kombinacioja
Multidirectional shading: Tobb fényforrast is felhasznal: 225°, 270°, 315°, és 360°
iranybol.

Elmélet:

A QGIS-ben kétféle algoritmus kozUl valaszthatunk, ha a domborzatarnyékolast szeretnénk
kiszamolni: az els6 a Zevenbergen-Thorne-algoritmus, a masik a Horn-formula. Mindkeét
esetben hasonlo az elv. A megadott pixel korili értékekbdl szamitja ki az adott pontra az
arnyékolast (a lejtész6g alapjan). Azt szokas mondani, hogy a Zevenbergen-Thorne
modszere a simabb, lankdsabb felszinekre jobb, mig a Horn-féle modszer a hegységi,
,erdesebb”, valtozatosabb felszinekre.

Itt lehet olvasni részletesebben a két mddszerrdl angolul:
https://macaulay.webarchive.hutton.ac.uk/LADSS/documents/DEMs-for-spatial-

modelling.pdf



https://macaulay.webarchive.hutton.ac.uk/LADSS/documents/DEMs-for-spatial-modelling.pdf
https://macaulay.webarchive.hutton.ac.uk/LADSS/documents/DEMs-for-spatial-modelling.pdf

Raster->Extraction=>Contour.

Beallithatd, hany méterenként kdvessék egymast a szintvonalak, és belekeriljon-e a
szintvonal magassaga az attributum tablaba. Jelenleg csak allandd szintvonalkéz adhato
meg.

A QGIS 3-as verzidiban végre van lehet6ség 3D-s megjelenitésre!
A 3D megjelenit6 ablak View meni > New 3D View ablakban érheté el.

Vektoros és raszteres adatok (és domborzatmodellek) egyarant megjelenitheték benne.

Ez a példa a domborzatmodellek megjelenitésére fog vonatkozni, a vektoros adatok 3D-s
megjelenitését egy masik fejezetben targyalom.

Legyen egy hipszometrikus szinezéssel ellatott domborzatmodell behivva a QGIS-be.
Elinditjuk az Uj 3D nézetet. Navigalni a 3D ablakban az egérrel lehet, lehet, vagy a navigacios
eszkozzel. Az iranytivel forgatunk (az égtaj beallithato)

Bal egérgomb: mozgatas/eltolasok, CTRL+bal egér: a kamera forgatasa

Egérgorgd: gorgetve: nagyitas/kicsinyités, lenyomva dontés, a kamera forgatasa,

Jobb egérgomb lenyomva kicsinyités/nagyitas

Az aktualis nézet egy raszteres képként (pl. jpg, png) kimenthetd (ez tulajdonképpen egy
printscreen).

A Configure-ban a kovetkezok allithatok:

A Terrain Type: Legyen a Flat Terrain helyett a DEM (Raster layer) domborzatmodell
(Elevation: pl. etopo1). A Vertical Scale a vertikalis tUlmagasitast adja meg. Ez altalaban 3-5-
(8) kdzott adjuk meg, mivel az 1 kevés, nem latszik belble szinte semmi. Ertéke figg a terilet
jellegétdl. Arra kell Ggyelni, hogy elkiloniljenek az egyes domborzati jellegek, de egy lankas
dombsagi teriletbdl ne készitsink magashegységet és forditva se!

Tile resolution: A modellt csempékre (tile-okra) bontva rendereli a program és jeleniti meg.
Tulajdonképpen itt lehet bedllitani a modell felbontasat. Minél finomabb, annal
eréforrasigényesebb a folyamat (er6s gépeken nem probléma, a régebbi kevesebb
memoriaval és gyengébb videodkartyaval rendelkezd gépeknél kell vigyazni, mert lefagyhat a
program). 16px azt jelenti, hogy 16x16 pixel egy csempe felbontasa.

Minél kisebb a felbontas, annal jobban latszanak az egyes tile-ok kozotti rések hegységi
terUleteken. A finomitassal ez elkerilhetd.

Skirt height: Néha kis repedések lathatok az egyes csempék kozott. Ha noveljik ezt az
értéket, akkor egy vertikalis falat fog hozzaadni a megadott szélességben, hogy eltinjenek
ezek a szakadasok.



Max. screen error: Megadja azt a kiUszobértéket, ahol az egyes csempéket egy
nagyobb/kisebb felbontasura kell kicserélni zoomolaskor. A kisebb szam tobb részletet jelez,
noveli a renderelés komplexitasat.

Max. ground error: A csempék felbontasa, amelyeknél a csempéket Ujra osztjuk a kdvetkezd
nagyitasi szinten egy részletesebbre. A kisebb érték mélyebb hierarchiat jelez, noveli a
rendelerés komplexitasat.

Show bounding boxes: Megmutatja 3D-ben az egyes csempék befoglald téglatestét.
(hibakereséshez)

Show Labels: mutatja a neveket.

Terrain Shading: Beallithato a felszin renderelése.

Shading disabled: A felszin szinét a térképi textura alapjan hatarozza meg.

Shading enabled: A felszin szinét a Phong arnyalasi modell alapjan hatarozza meg:
figyelembe veszi a texturat, a modell normal vektorat, a felszin anyagat, a kdrnyezd és sajat
szinét és a fényességet (visszatUkrozodést).

A Phong-féle arnyalasi modellrdl: https://en.wikipedia.org/wiki/Phong shading

Lights: 8 fényforras adhato hozza:
ezek x,yz koordinatai, szine (color), intenzitasa (intensity), attenuation (ezek csillapitasa)

Az alabbi képe egy domborzatmodell 3D nézete lathato.
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Ezen a képen pedig a domborzatmodellre rahUzott OpenStreetmap térkép latszik.


https://en.wikipedia.org/wiki/Phong_shading
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TIN interpolacio:

»A domborzatmodellezés korai szakaszdban szamos kutatds foglalkozott szabalytalan
modelleken optimalis hdromszdghaldzat szerkesztésével. Mara a Tom Poiker altal kidolgozott
TIN (Triangulated Irregular Network) mddszer valt altalanossa. Az ArcGIS is ezt alkalmazza.
A TIN megszerkesztése a korabban targyalt Thiessen poligonok szerkesztése utan egyszeriien
elvégezhetd, ha 6sszekotjiik mindazon pontokat, amelyek Thiessen poligonjai érintkeznek
egymassal. Bizonyithatdo, hogy ez a halézat a lehetd legzomdkebb (az egyenld oldala
haromszogekhez legkozelebb 4l16) alakzatot adja.

Miutén a globalis TIN halozat rendelkezésre all, az interpolacid haromszdgenként (lokalisan)
egy-egy ferde sikkal torténik.” (Markus, Térinformatika 11. Interpolacio és
domborzatmodellezés)

Ajanlott olvasmany:
https://regi.tankonyvtar.hu/hu/tartalom/tamop425/0027_TEI11/ch01s03.html

Feladat: hivjunk be a 24 pontot tartalmazé adllomanyt, amelyben a magassag mez0 tartalmazza
a pont Z koordinatajat (fiktiv teriilet).

A Processing toolbox megnyitasa utan keressik meg az Interpolation szekciot->TIN
interpolation.

Input: Bemenet lehet pont és vonalas réteg.

Interpolation attribute: melyik mez6 alapjan interpolaljunk (ez lehet Z koordinata is)

Vector layer zold+ ->tobb vektoros réteg is figyelembe vehetd. Most csak a pontokat
hasznaljuk, Type> point.

Interpolation method: linear: linedris-> durva, szogletes feliletet eredményez. Clough-
Toucher (Cubic): gorbékbdl all6 felilet.

Extent: itt a Calculate from layer->kiterjedése megadasa

Output raster size!!!

Mekkora legyen a felbontas? Itt 100 méteres racshalonal a 1-10 m kdzott barmi lehet. Tul kicsi
ne legyen, mert sokaig dolgozik a QGIS.

Interpolated: mentés helye.


https://regi.tankonyvtar.hu/hu/tartalom/tamop425/0027_TEI11/ch01s03.html

2.5D Nézet a QGIS-ben

Ahogy a neve is mutatja, nem jon létre a 3D-s jelenet (3D View), csupan haromdimenzios
hatasu kétdimenzios nézetet generdl a QGIS. Leginkabb épiiletek megjelenitésénél hasznaljuk.
Aktivalasa: Layer Properties> Symbology>2.5D

Height: épiilet magassaga,

Angle: a sz0g, amerre az épiiletek dolnek.

Roof color, Wall color: tetd, fal szine.

Shadow: arnyék szine és mérete

Hétranya: lassan rendereli a nézetet.

Feladat: épiileteket tartalmazo réteg 2.5 D-s megjelenitése a fentiek alapjan.



